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Getting Started

Your Zoom™ PCI (Peripheral Component Interconnect) internal
cable modem is designed to connect your personal computer
to the Internet through the same cable that you use for
television reception.

Contacting Your Cable Company
Please fill out the information in the following table before you
begin installing your Zoom cable modem. Your cable service pro-
vider needs this information to ensure that your modem connects
to the Internet successfully. Note: This manual assumes that you
have already arranged for cable modem service and established a
cable modem account with your cable company.

Important Installation Information
The following information is located on a label on your modem. You will

be asked to provide it when you call for installation.

Product Name: Zoom CableModem
Model: __________
S/N: _____ - _______ - ____ - _____ - ______

C-MAC Address:__________________________

To connect your PCI cable modem to your computer, you will need its
MAC Address. If you don’t know it or can’t find it, see page 37 for detailed

instructions.

PCI MAC Address:_________________________
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Package Contents
In addition to this manual, your package should include the fol-
lowing items. If anything is missing, contact your dealer or cable
service provider.

• PCI cable modem

• Software on a CD-ROM

Minimum System Requirements

• Windows® 98/Me/2000/XP.

• Available PCI slot in your computer.

• 24 MB RAM.

You Will Also Need
To complete your installation, you must have these items:

• Cable modem service provided by your cable company. The
service must be DOCSIS- (Data Over Cable Service Interface
Specification) or EuroDOCSIS-compatible, where applicable.

• A cable outlet.

• A 75-ohm coaxial cable that will connect to the cable TV sys-
tem and that can reach to the computer that will contain your
cable modem.

Note: Because there is great variety in the way cable is installed,
Zoom does not provide a coaxial cable to connect your
modem to your cable system. Your cable company may
provide the appropriate length cable for your use. If the
company doesn’t supply the cable, you should buy a coax-
ial cable with an RG-59 or RG-61U rating (75 ohm) and
industry-standard F connectors.
Tip: For best performance, do not use “push-on” F con-
nectors; use only “screw-on” F connectors.
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1
Installing Your Cable Modem

Note:Note:Note:Note: If your cable company provides you with an installation
procedure, follow it instead of the instructions in this
chapter.

This chapter describes how to install your Zoom PCI cable
modem in your computer and connect to your cable service.

Installation consists of a few simple steps:

1. Install the software.

2. Install the hardware.

3. Ensure that the automatic synchronization procedure is
successful.

Installing the Software
Install your cable modem software first, before connecting the
modem hardware. Follow these steps.

1 Your computer should be on. Insert the Zoom CD into your
computer’s CD-ROM drive. The CD will start automatically.
(If it doesn’t, from the desktop, go to Start | Run and then
type d:\setup.exe, where d: is the letter of your CD-ROM
drive.)
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2 When the main menu appears, click Cable Modem Installa-
tion Wizard.

Be sure to read the Prepare to Install directions, take action
as needed, and then click Continue.

3 When the Choose Your Modem dialog box displays, click the
PCI Internal Cable Modem button.
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4 The Zoom PC Resource Checker checks your computer to
verify that it has appropriate resources to support your cable
modem model. You will see a dialog box similar to the one
below.

• If your computer has the recommended resources, click
Continue to proceed.

• If your computer does not have the recommended re-
sources, click Details and follow the instructions to rectify
the problem.

5 The Setup Wizard continues the software installation process.

6 When prompted, click NO, I will restart my computer later,
and then click Finish.

Be sure to remove the CD from your computer when you’re
done.

7 Shut down your computer.

The next stage is to install the hardware.
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Installing the Hardware

Remember: You must install the PCI cable modem software
before you install the hardware. Refer to the sec-
tion on page 5.

1111 If you have not already done so, record the modem’s C-MAC
and PCI-MAC addresses in the table on page 1. These ad-
dresses are printed on the label on the bottom of the modem
card. You may need to provide these addresses to the cable
company after the modem is installed, and the label will not be
visible then.

2222 Shut down Windows if you have not already done so, and turn
your computer off and unplug it. Don’t plug it back in or turn
it on until you have completed the hardware installation.

3333 Take the cover off your computer. You will probably have to
remove several screws on the back of the case. Most likely the
screws are near the outer edges.

4444 On the back of the computer, unscrew and remove the metal
plate that is covering an available PCI slot.

The PCI slot is shorter than other slots and usually a different
color (PCI slots are usually white or gray). Your cable modem
has three sections of gold connecting fingers, and a PCI slot
has three sections that match the ones on your cable modem.

CAUTION

Electrostatic Discharge Protection

Static electricity can damage components on your
PCI cable modem or inside your computer. Before
removing the board from its antistatic bag, touch
the computer’s metal chassis to statically discharge
yourself.
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5555 Remove your PCI cable modem from its antistatic bag and
insert it firmly into an available PCI slot. See the following
illustration:

PCI Slot

Be sure that the gold finger end of the card is properly seated
into the connector. If you have a tower or mini-tower com-
puter case with a vertical main board, turn the computer gently
on its side so you can push straight down on the modem card
to insert it firmly in its slot.

Line the bracket up and screw it into the computer using the
screw you removed with the cover plate.



10 Zoom Cable Modem User’s Manual

6666 Connect the coaxial cable.

• If you have a wall outlet cable jack, connect one end of
the coaxial cable to it and the other end to your com-
puter’s PCI modem jack as shown below.

• If you don’t have a wall jack, you should have a length of
coaxial cable entering your house close to where you want
to locate the computer that houses the cable modem.
Connect the end of this cable to your computer’s PCI
modem jack as shown below.

7777 Replace the computer cover.

8888 Restart your computer.

You should see a dialog box similar to the one below.

Note: If this dialog box does not display automatically, go to
Start |Programs |Zoom Cable Modem |Cable Modem
Monitor.

Select your computer’s PCI card from the dropdown list and
click Next.
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9999 The following dialog box displays.

Click Restart System.

The modem starts an automated power-up process that is de-
scribed below.

Note: The Resource Checker, User Manual, and supplementary
software are also installed on your computer during this
installation procedure. For removal instructions, see page
21.

The Modem’s Power-Up Process
Your cable modem now performs an automated power-up process
and synchronizes itself with the cable system.

The LEDs on the modem bracket indicate the progress of syn-
chronization. The green Status LED at the top or far right of the
bracket blinks, rapidly at first and then slowly. When synchroniza-
tion is complete, this LED becomes steady On. The yellow Activ-
ity LED, which flickers when the modem is sending or receiving
data, may also flicker during synchronization. The remaining LED
is reserved.

Note: It may take a few minutes for the modem to register with
the cable system. If the modem does not synchronize, re-
fer to page 24 for help.
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Note: If you experience an outage with your cable TV service,
your cable data connection will most likely also be off. If
you are unable to connect to the Internet, or if your
browser notes that it is unable to find a selected URL,
check to ensure that you have cable TV service available.
If not, contact your cable service provider.

At this point, the system at your cable company will communicate
with the modem and computer to finalize the installation. This part
of the installation varies from company to company, so you should
follow the directions that are given to you.

In some cases, the cable company will automatically query the cable
modem via the cable connection. In other cases, your cable com-
pany may have instructed you to phone back with your cable mo-
dem’s MAC address once the hardware installation is complete.
The cable company may need the cable modem’s MAC addresses
(located on your cable modem’s label), or request billing informa-
tion. Refer to the table on page 1.

The Next Step
If you are like the majority of users, your cable modem installation
is complete. Turn to Chapter 3 (page 16) to learn how to use your
modem. The only exception is as follows:

• Your Internet browser setting may need adjustment. If you are
unsure, turn to Chapter 2 (page 13) for advice.
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2
Configuring Your Browser

An Internet browser is a program used to find and display Web
pages. To find a page, the browser must connect to the Inter-
net, either via phone lines or a LAN (Local Area Network). If
you are using a cable modem, your browser needs to connect
to the Internet via a LAN. This chapter describes how to config-
ure some of the most common Internet browsers. It is beyond
the scope of this manual to give step-by-step instructions for all
versions of all browsers, so the instructions below cover only
the major versions of the most common browsers. If you are
using another browser, please consult the documentation that
came with it.

Internet Explorer 4.0

1 Start Internet Explorer.

2 Open the View menu and select Internet Options.

3 In the Internet Properties dialog box, click the Connections
tab.

4 Click Connect to the Internet using local area network, and
click OK.
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Internet Explorer 5.x or Later

1111 On the desktop, click the Internet Explorer icon.
If you cannot access the Internet Explorer menu, follow these
steps:

• Click Start | Settings | Control Panel.
• Click the Internet Options icon, and go to Step 3.

2222 Click the Tools menu, and then Internet Options.

3333 In the Internet Properties dialog box, click the Connections
tab.

4444 On the Connections tab, click the LAN Settings button.
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5555 In the Local Area Network (LAN) Settings dialog box, se-
lect Automatically detect settings and click OK.

Netscape Navigator

1111 On the desktop, click the Netscape Navigator icon.

2222 From the Edit menu, select Preferences.

3333 In the Preferences dialog box, click the Advanced option,
and then click Proxies.

4444 Select the option that allows you to connect to the Internet
directly.

AOL

AOL 5.0 or higher has a cable modem option that configures your
connection automatically.
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3
Using Your Cable Modem

This chapter explains how to use your cable modem, including
the following instructions:

• How to connect to the Internet.

• How to use the CM Monitor Utility.

• What to do if you lose power.

• How to remove your PCI cable modem.

Connecting to the Internet
Once you have correctly installed your Zoom PCI cable modem, it
will power up and synchronize itself with the cable network. You
know that your PCI cable modem is properly connected and syn-
chronized if the green STS light remains steady On.
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Light Name Mode Status
STS (Status) Off

Blinking Fast
Blinking Slow
On

Power is off.
Ranging is in process.
Registering is in process.
Online and fully operational.

ACT (Activity) Flashing Traffic activity through the cable
modem.

FCN (Function) On Reserved.

After your cable modem is synchronized, connecting to the Inter-
net is as simple as clicking on the icon that corresponds to the de-
sired Internet application.

Note: Your browser should be configured so that it connects via
a LAN. If you need help changing the way it connects,
turn to page 13.

The Zoom CM Monitor Utility
The Zoom CM Monitor Utility is automatically installed when you
install the cable modem software.

The utility is intended for both end users and cable service provid-
ers. It is meant to eliminate or decrease the number of cable com-
pany “truck rolls” and to save subscribers and service providers
time and money.

For end users installing the modem themselves, should a question
arise pertaining to the installation, the application can help during a
call to the cable company.

Cable company field technicians can monitor the cable modem
during the range and registering portion of the installation and
quickly troubleshoot any problems encountered during the initial
setup process.

To access the CM Monitor, from the desktop click Start | Pro-
grams | Zoom Cable Modem | Cable Modem Monitor. Then
double-click the monitor icon in the system tray:
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A dialog box similar to the one below displays.

The system tray icon (and the Status and Activity buttons) can be
one of three colors, indicating the modem’s connection status.

• Green: The modem is online and synchronized.

• Yellow: The modem is in the process of connecting.

• Red: Synchronization has been lost and the modem is trying to
connect.
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Depending on your cable modem model, you may be able to click
the More Details button for more technical information. The ta-
ble below defines this information. Most fields have “rollover” text
definitions: If you move your mouse over a field’s label, a defini-
tion of that field pops up.

Note: All these fields may not be visible for all cable modem
models.

Port Type PCI

Modem Status Online or Connecting

Traffic Meter:
CM to PC

The data rate, expressed in
bits/second, and the total amount
of data, expressed in bytes, from
the cable modem to the computer.

Traffic Meter:
PC to CM

The data rate, expressed in
bits/second, and the total amount
of data, expressed in bytes, from
the computer to the cable modem.

Reset Meter Clicking this button clears all traf-
fic fields.

Sync Status
Activity (ACT)

These lights indicate status and
any activity.

Hide Details Clicking this button closes the
more details screen.
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Connecting Status A text message that describes the
cable modem’s current mode.

C-MAC Address The cable modem’s RF MAC ad-
dress.

PCI MAC Address The cable modem’s PCI-to-PC
interface MAC address.

Serial Number The cable modem’s serial num-
ber.

Downstream Frequency (Hz) The frequency over which the
service provider’s head-end
transmits data to the modem.

Downstream SNR (dB) The signal/noise ratio (SNR) on
the downstream data channel,
from the service provider’s head-
end to the cable modem.

Upstream Frequency (Hz) The frequency over which the
cable modem transmits data to
the service provider’s head-end.

TX Signal Level (dBmV) The cable modem’s transmit
power output level.

Firmware Version The cable modem’s firmware ver-
sion number.

Registration Phase As the modem completes each
stage of the registration process,
a checkmark appears in each box.
The Connecting Progress bar on
the bottom of the dialog box tracks
this progression: When all stages
are complete, the bar is solid, and
Modem Status is Online.

Right-clicking the system tray icon displays a brief menu of op-
tions. From here, you can

• Open the CM Monitor’s Status screen.

• Close the CM Monitor’s Status screen.

• Quit the CM Monitor application.

• Review information about the application.
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Ending an Internet Session
After you have completed your Internet session, close the browser
you are using. The Zoom cable modem will remain connected with
the cable system and will be ready to open another session.

If You Lose Power
If you unplug your cable modem, or if power is lost for any other
reason, all communication between the modem and the cable sys-
tem will be terminated. When the power is restored, the cable mo-
dem must go through the full startup and connection process be-
fore you can connect to the Internet. This process will be per-
formed automatically when the modem is powered up.

Note: Your cable company may request that you always keep
your cable modem on so that software maintenance can be
performed at night.

Removing Your Cable Modem
To remove your Zoom cable modem, follow these steps.

1111 Quit all running programs.
Note: This includes the CM Monitor Utility.

2222 From the desktop, go to Start | Programs | Zoom Cable
Modem and then select Cable Modem Uninstall. The Un-
install Wizard dialog box displays. Click Next.
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3333 When the process is done, the following dialog box displays.

Click Finish.

4444 Shut down Windows, and turn off and unplug your computer.

5555 Take the cover from your computer by removing the screws
on the back of the case.

6666 Remove the screw that holds the PCI cable modem card in
place. Gently remove the PCI cable modem card.

7777 Replace the metal cover plate that you removed during instal-
lation. Now use the screw that was holding the PCI cable mo-
dem in place to secure the metal bracket.

8888 Replace the computer’s cover and restart your computer.

Note: The Resource Checker, User Manual, and complementary
software are also installed on your computer as part of the
cable modem installation process. When you perform the
instructions above, everything associated with your cable
modem is removed.
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Appendix A
Troubleshooting

This section provides tips to troubleshoot your cable modem in
the event of minor problems. By referring to these tips, you
may be able to quickly find a solution and avoid a call to
Technical Support or your cable service provider. You may also
want to refer to the Frequently Asked Questions, or FAQs,
located on the CD, or visit our Web site.

There is also a section describing our Zoom Cable Modem
Monitor Utility (see page 17). This utility is intended to help
technicians assist customers quickly and easily.

Note: If your cable modem is not responding, the first step
should be to reset it. This may take a few minutes, but it is
frequently the quickest and easiest solution.

How do I know if my cable modem has properly synchro-
nized with my Cable Service Provider’s cable system?
When your PCI cable modem is synchronizing with the cable sys-
tem, it is actually performing a two-step process. It is ranging and
registering. When it is ranging, it is trying to send a message to the
cable system. When it is registering, it is trying to receive a message
from the cable system. The STS (Status) light will blink quickly
when it is ranging, and it will blink slowly when it is registering.
The cable modem is synchronized when ranging and registering are
complete. The STS light will stay on when the cable modem is syn-
chronized and ready for use.
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What do I do if the cable modem does not synchronize with
the Cable Service Provider’s cable system?
If the STS light keeps blinking for a significant amount of time, the
PCI cable modem is not synchronizing. Below are some steps you
can take to solve the problem:

1. Check the cable connection at your cable outlet, and on the
PCI cable modem.

2. Check to make sure that cable modem service is being pro-
vided. Is your TV receiving a cable signal? TV and broadband
access are provided over the same cable, so if one is out, the
other is out.

3. Contact your cable service provider.

What do I do if the indicator lights on my PCI cable modem
are not doing anything?
1. Check to see that your computer is turned on. Your computer

provides power to the PCI cable modem. If your computer has
no power, neither does the PCI cable modem

2. Check to see that the PCI cable modem card is properly in-
serted in your computer’s PCI slot.

CAUTION: Turn off and unplug your computer
before touching any internal components.

I receive the message “Cannot Find Files; Insert Operating
System Disk.”
Your computer is looking for the files included on the original op-
erating system CD or disks that came with your computer. Remove
your modem CD or disk (if any) and insert your operating system
CD or disk. Be sure to remove the Windows CD when you’re done
and reinsert your modem CD or disk if applicable.
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The cable modem’s STS light blinks for 5 minutes, goes off,
comes on again, and repeats.
Check with your cable service provider to make sure that high
speed access is available and running.
In rare instances, the cable signal may be weak or noisy. Be sure
the modem is attached to one of the ports on the first splitter after
the cable enters your home or office. Refer to the following dia-
gram or contact your cable provider.

Make sure there is no video amplifier on the same line with the
cable modem. (A video amplifier prevents data from returning to
the cable service provider's central office.)

Note: Sometimes, when your cable modem service is restored
after a disruption, you may experience difficulty communi-
cating. If this happens, disconnect and reconnect the
power, and let the modem perform the automated syn-
chronization process again.
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Appendix B
Locating Your PCI MAC Address

You must provide your cable company with your modem’s PCI
MAC address. This address is printed on a label on the modem
hardware as well as on the box. However, if you don’t have
access to either of these items, you can determine this MAC
address by following the instructions in this Appendix. The
instructions vary depending on your computer’s operating
system. (Note: The CM Monitor Utility also displays the PCI
MAC address.)

For Windows 98/Me:
From the desktop, click Start | Run, type winipcfg, and click
OK. Click more info, then select the PCI card you are using. The
12-digit Adapter Address is your PCI MAC address. Make a note
of it in the table on page 1.

For  Windows 2000/XP:
From the desktop, click Start |(All) Programs | Accessories |
Command Prompt. Then type ipconfig /all and press Enter.
Make a note of the 12-digit Adapter Address in the table on page 1.
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Appendix C
Regulatory Information

FCC 47 CFR Part 15 Emissions Statement
This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to 47 CFR part 15 of the Rules. These limits are designed
to provide reasonable protection against harmful interference in a residential in-
stallation. This equipment generates, uses and can radiate radio frequency and, if
not installed and used in accordance with the instructions, may cause harmful
interference to radio communications.
However, there is no guarantee that interference will not occur in a particular in-
stallation. If this equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off and on, the user
is encouraged to try to correct the interference by one or more of the following
measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to

which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

Industry Canada Emissions Statement
This Class B digital apparatus meets all requirements of the Canadian Interference-
Causing Equipment Regulations.
Cet appareil numérique de la classe B respecte toutes les exigences du Règlement
sur le matériel brouilleur du Canada.

Electrostatic Discharge Statement
This unit may require resetting after a severe electrostatic discharge event.

Declaration of Conformity
The manufacturer declares under sole responsibility that European models of this
equipment comply to Directive 1999/5/EC (R&TTE Directive) via the following:

Directives Standards
73/23/EEC EN 60950 (1992) with the following

Amendments: A1, A2, A3, A4
89/336/EEC EN 55024 (1998)
89/336/EEC EN 55022 (1994) with Amendments A1, A2

The product is CE marked.
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This document contains proprietary information protected by copyright, and
this Manual and all the accompanying hardware, software, and documen-
tation are copyrighted. No part of this document may be photocopied or
reproduced by mechanical, electronic, or other means in any form.

The manufacturer does not warrant that the hardware will work properly in
all environments and applications, and makes no warranty or representa-
tion, either expressed or implied, with respect to the quality, performance,
merchantability, or fitness for a particular purpose of the software or docu-
mentation. The manufacturer reserves the right to make changes to the
hardware, software, and documentation without obligation to notify any
person or organization of the revision or change.

All brand and product names are the trademarks of their respective owners.

© Copyright 2002
All rights reserved.
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